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eFLOW Extract Validate
In the eFLOW Extract Validate station, you can correct and complete fields that were not correctly recognized

or that did not pass validations in the Recognize station.

Note: eFLOW Extract Validate is customizable. Depending on your system configuration, some features

described in this guide may not be available, or may be different than described.

Open Validate
In eFLOW Launch, select your eFLOW application, then click the Validate button.

The Validate window opens. Usually, collections load automatically and the fields and image are displayed.

If collections do not automatically load, click the Get Batch button.

You can now navigate to fields that need correction and type in the values, transfer them from lookup tables

or capture them from the image.
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Fields and values on the image are highlighted:

Color Screen area Meaning

Green Field layout Fields with a correct value. Non-mandatory fields without a value are also

highlighted in green.

Blue Image Recognized fields.

Yellow Field layout and

image

Currently selected field.

Red Field layout Invalid mandatory field. You must correct invalid fields before you can

move to the next field or form. If you cannot correct the value for some

reason, set an exception.
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Layouts
The layout of the fields depends on the configuration, and on the invoice type. The invoice type can be one of

the following:

n MM invoice: relates to a purchase order and has line items

n FI invoice: does not relate to a purchase order and has no line items

n FIP invoice: does not relate to a purchase order, but has line items

The name of the current layout is displayed at the bottom right of the screen. To select a different layout (if

available), click the arrow and select the layout from the list.

If configured, you can also click the FI, FIP and MM buttons to change the invoice type, and therefore also

the layout: . When you change the invoice type, the appropriate validations for that invoice type

are applied.

Collections
Use the following buttons or shortcut keys to work with collections.

Command Button Shortcut Description

Get Batch F6 Retrieves available collections from the server.

The number of collections retrieved in one batch is defined in the

Validate station configuration.

Available only when no batch is currently loaded.

Put Batch F7 Writes the collections back to the server after work on the

collections is completed.

Available only when all fields in the collection are valid.

Save Batch CTRL+B Saves the collections without writing them back to the server.

Discard

Batch

CTRL+ALT

+B

Discards the collections without saving any changes.

Forms

Navigation

F12 Displays the Forms navigation window with thumbnails of all

pages of all forms. Click a thumbnail to display a specific page.
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Command Button Shortcut Description

Exceptions ALT+E Opens the Exceptions list dialog box. See Exceptions.

Shortcut

Editor

F1 Opens the Shortcut Editor.

Navigation
Use the following shortcut keys to navigate between fields and forms.

Go to Shortcut Description

Next field TAB The next or previous field is determined by the tab index

order defined in the Layout Designer.
Previous field SHIFT+TAB

Next invalid field ENTER The next or previous invalid field is determined by the tab

index order defined in the Layout Designer.

When there are no more invalid fields in the current form, the

cursor moves to the next form that contains invalid fields, if

such a form exists.
Previous invalid field SHIFT+ENTER

Next form CTRL+PGDN Available only when all fields of the current form are valid.

Previous form CTRL+PGUP

In the Forms navigation window, you can navigate between forms and their pages. Click the Forms

Navigation button or press F12 to open this window.

Each form page is displayed as a thumbnail. An arrow indicates the form whose input fields are currently

displayed in the layout window.

Forms and pages with invalid fields are marked with a cross . Forms and pages with no invalid fields are

marked with a tick .
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Click on a thumbnail to view the page in the image viewer.

Note: Clicking on a thumbnail simply displays the image of the selected page in the image viewer. It does

not change the display in the layout window to show the input fields of the form to which the selected

page belongs.

Image viewer
Use the following buttons or shortcut keys to work with images.

Command Button Shortcut Description

Zoom In CTRL + Increase the image size.

Zoom Out CTRL – Decrease the image size.
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Command Button Shortcut Description

Fit Viewer to Window

Width

F2 Adjust the image viewer to show the full image

width.

Fit Viewer to Window

Size

F3 Adjust the image viewer to show the entire image.

Rotate Left CTRL+Q Rotate the image counter-clockwise.

Rotate Right CTRL+P Rotate the image clockwise.

Show/Hide Image Viewer ALT+V Display or hide the image viewer.

Switch Screens ALT+W Open the image in a separate window. This is

useful, for example, if you work with two

monitors: you can display the fields on one

screen and the image on the other.

Tables
Use the following buttons or shortcut keys to work with tables, such as the line items table in MM or FIP

invoices.

Command Button Shortcut Description

Delete Row CTRL+H Deletes the current row.

Insert Row Above CTRL+I Inserts a new row above the current one.

Insert Row Below CTRL+J Inserts a new row below the current one.

Copy Row From

Above

CTRL+K Copies the row above the current one and inserts it as a

new row.

Delete Table Deletes the entire table.
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Lookup tables
Lookup tables enable you to search for field values and transfer them to the fields. The following lookup

tables are available:

Table Shortcut Description

Receiver Lookup F9 Click in the Company Code field, then press F9.

Vendor Lookup F9 Click in a vendor field, then press F9.

PO Items Lookup CTRL+F9 Click in the PO No. field, then press Ctrl+F9.

Receiver and vendor lookups

1. Enter search criteria, then click the Search button.

2. Select a record, then click Yes to transfer the values of the selected record to the fields.

PO Items Lookup

1. Select Positions-PO or Positions-DeliveryNote, depending on whether you want to find values in the

purchase order or a delivery note.

By default, the items of the recognized purchase order or delivery note are displayed. To search in a

different PO or delivery note, click the DeliverynoteNo or the PONumber button, type in the number and

click the button again. You can add multiple numbers.
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2. Click in the check box to select items whose values you want to transfer.

Click to select all items and to deselect all items. You can also change the position of the items

by clicking the arrow buttons .

3. Click the Apply button.

Capture values from the image
You can capture a value on the image and transfer it directly to a field.

1. Click in the field.

2. Hold down the left mouse button and draw a rectangle around the corresponding value in the image.

Exceptions
If you are unable to complete a field or an entire form for some reason, you can mark it as an exception.

Collections with exceptions move to the Escalate station, where they can be handled by other users.

1. Click the Exceptions button.

2. In the Exceptions List dialog box, select an exception and enter a description of the problem (optional).

3. Click OK.
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FIP supplier assignments
FIP invoices (non-PO related invoices with line items) usually require that accounting information is assigned

to each line item. eFLOW Extract can automatically assign accounting information based on identifiers

quoted on the invoice, such as mobile phone numbers or car registration numbers. You can add and change

these assignments in the Validate station.

1. In the Vendor ID field or the Identifier field, press CTRL + F9.

The Supplier Assignments dialog box opens.

Suppliers for which account assignments are already defined are indicated by the FIP icon in the

Suppliers list.
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2. Perform one of the following actions:

Action Details

Search for a

supplier

Enter the client, company code and supplier ID in the search fields at the top

left of the dialog box, then click the Search button .

Leave the Supplier ID and Supplier Name fields blank to list all FIP

suppliers for the client and company code.

Change an existing

assignment

1. Click the supplier and then click the line with the assignment you want to

change.

2. Enter the new values in the fields at the bottom of the dialog box, then

click the Update selected assignment button .

Add assignments

for a new supplier

1. Right-click the supplier and select FI Positions.

2. Enter values in the fields at the bottom of the dialog box, then click the

Add a new assignment button .

Delete an

assignment

Click the line with the assignment, then click the Delete selected

assignment button .

Delete all

assignments for a

supplier

Right-click the supplier and select FI Positions.

3. Select Menu > Exit to save your changes and close the dialog box.

Information dialog
Press F6 to open the Information dialog, which provides the following information.

Tab Available information

Page-Recognition-Info Scripts or learning schemas that were used to identify field values.

Receiver-Info How the receiver information was found.

Supplier-Info How the vendor information was found.

Usertag-Info Values of user tags.
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Shortcut editor
You can edit the default shortcut keys.

1. Click the Shortcut Editor button.

2. In the Shortcut Editor dialog box, select the shortcut you want to change.

3. Click in the Press shortcut keys field and press the key combination you want to use.

4. Click the Assign button.
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eFLOW Extract Learning
The Learning feature of the eFLOW Extract Validate station enables you to teach eFLOW Extract how to find

correct field values. Learning involves creating a “schema”, which specifies how the learning is identified (by

text or supplier ID) and the position of the fields. Learning schemas are applied after the regular recognition

scripts.

After you create learning schemas, they are applied directly to the next collection that passes through the

Recognize station. It is not necessary to restart the Recognize station.

Open Learning
To open Learning, in the Validate or Escalate station, press the F5 key.

The Learning window opens.

The left pane lists the fields and tables that can be learned. Which fields and tables are available here can be

configured in the file ConfigFieldLearning.appconfig.
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The middle pane displays the image. To open an image, on the Image menu, select Add.

The right pane displays the schema, field or table settings, depending on which element you select in the left-

hand pane.

To create a learning schema, you select a learning method, enter a unique schema name, learn the fields or

tables, and then save the schema.

Schemas
Use the following menu items to work with schemas.

Action Menu item Notes

Save a schema Schema > Save Before saving a schema, in the settings pane, enter

a unique Name and, in the case of an ID-based

schema, a schema ID.

Optionally, in the Pages list, select an option to

apply the settings to all invoice pages, only the first

page, only middle pages, or only the last page.

You can save the schema with or without the image.

Depending on the configuration, schemas are saved

in the FieldLearning database or on a file share.

Create a schema File > New To load an image for the new schema, on the Image

menu, select Add.

Open a schema Schema > Open Type a Name and click the Search button to find

the schema.

Disable a schema Schema > Edit The Recognize station ignores disables schemas.

To find the schema, type a Name and click the

Search button.

Check the Deactivated check box and click the

Change button.

Export a schema File > Export You can export selected schemas or all schemas to

individual files or to a single file.

Import a schema File > Import Note that existing schemas are overwritten when

importing.
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Action Menu item Notes

View schemas

defined for the

current collection

Schema > Current

collection

This menu item is only available if you open Learning

from Validate or Escalate.

Learning methods
n ID-based learning:

The schema is identified by a supplier ID. This method requires that the supplier has already been

identified. The ID may consist of just the supplier ID from the reference database, or the client, company

code and supplier ID, for example 100.2000.123456. Leading zeros are ignored.

You can only create one ID-based learning schema per company code and client.

n Text-based learning:

The schema is identified by the image contents. You can define up to three texts that the image must

contain in order for the schema to be applied.

A text-based learning schema is valid for all company codes and clients and is usually used when an

incorrect vendor or no vendor was identified, or when multiple layouts exist for a vendor.

ID method

1. In schema settings pane, in the Method list, select ID.

2. If necessary, in the ID field, enter a supplier ID.

When you open Learning from the Validate or Escalate station, the ID field is automatically filled if the supplier

has been recognized.

Text method

1. In schema settings pane, in the Method list, select Text.

2. In the Text1 field, enter a text located somewhere on the invoice.

3. Click the Draw rectangle button and draw a large rectangle around the text on the image. You must

draw a large rectangle, because, unlike fields, no tolerance rectangle is added.
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4. (Optional) Enter Text2 and Text3 and draw the corresponding rectangles. Select the appropriate

Conjunction:

l AND: all texts must be found

l OR: any one of the texts must be found

5. You must specify a Confidence level, because characters of the text may not be correctly recognized.

Normally, you should not need to change the default confidence value of 80.

Fields

Learn a field

1. In the fields list, select a field.

2. Click the Draw rectangle button and draw a rectangle closely around the corresponding value on the

image. A tolerance rectangle is automatically added, which is only visible on the image when the field is

selected.

Unlearn a field

If a field has been incorrectly recognized by the recognition scripts, you can “unlearn” the field. For example,

a number on the invoice may have been recognized as the delivery note number, but no delivery note number

is actually quoted on the invoice.

In the fields or tables list, right-click the field and select Field does not exist.
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Tables
Table learning is similar to field learning, with the following differences:

n An entire table row is learned instead of a single field.

n Vertical tolerances are not relevant.

n Rules can be defined.

Note: Table recognition can be slow if many columns, or columns that cannot be validated, such as the

description, have been learned.

Learn a table

You learn tables by drawing rectangles around their fields (see Fields). Whenever possible, you should learn

all fields in the first row of the table, especially the amount, unit price and line total. The line total is particularly

important because this value is required by the underlying script that supports field recognition.

Unlearn a table

In the tables list, right-click the table and select Table does not exist.

You can only unlearn the entire table, not individual fields.

Table settings

To open the table settings, in the table list, select the table.

The Max. Difference defines the number of pixels within which the following row is located.

Normally, for items with 1-2 rows, you do not have to change the value of 120. For items with 3 rows or more,

you should only increase or reduce the value accordingly if the item rows are very close together and were

partially skipped.
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Table rules

Table rules specify the position of the table fields in relation to one another.

1. In the tables list, select the table.

2. In the settings pane, click in the Rules field, then click the  button.

3. In the Rule Manager dialog box, right click Rules and select New.

4. Click New rule 1 twice and enter a name.

5. Right-click the rule and select Edit.

6. In the Rule Editor, add fields, positioning elements and values to build the rule syntax, which is

displayed in the box at the top of the dialog.

7. Click OK to save the rule.

Action Follow these steps

Add a field to the

rule
Select the field and click the button.

Add a

positioning

element

Select one of the options in the Resulting rule area.

Add a value Enter a Value and click the  button.

Remove an item

from the rule

Click the Undo button. This removes the last item that you added to the rule. Click

Undo again to remove more items from the rule.

Keywords
Defining the field location is usually sufficient for fields whose position remains the same for all invoices of a

supplier. For fields whose locations may not be the same on all invoices, you can define keywords to aid

recognition. For example, the location of line item amounts can differ depending on how many rows the line

items table contains.
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1. Click in the Keywords field, then click the button.

2. Type keywords and specify their location in relation to the field value: to the left or right, or above or

below.

3. Specify the confidence level for each keyword.

4. Click OK.

Masks
Masks enable you to define a pattern that the field value must match. For example, the invoice number for a

supplier may consist of 4 numbers, then 3 letters, and then 6 numbers, separated by hyphens: 2015-ABC-

123456.

1. Click in the Masks field, then click the  button.

2. Type the pattern that the field value must match.

For example, to define a mask for invoice numbers like 2015-ABC-123456, enter @@@-###-@@@@@@.

n The @ sign represents any number.

n The # sign represents any lowercase or uppercase letter.

n You can also enter specific characters and numbers.

Instead of using the placeholders @ and #, you can define the masks as regular expressions. In this case,

you must check the Is regex check box.

3. Select a Confidence value.

4. (Optional) To disable the regular recognition validation for the field and use only the learning schema,

check Disable standard validation.

5. Click OK.

Replacements

In the Masks and regular expressions dialog box, click the button.
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Enter the value to be replaced and the value that will replace it.
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